How to Use the
Microsoft Unlimited
Potential Community
Learning Curriculum

About Unlimited Potential

More than ever before, adults need to reinvent themselves many times over to
keep up with the larger changes occurring in the world of the 21st century.

Microsoft® Unlimited Potential (UP) is a global program focused on
improving lifelong learning for young people and adults by providing
technology skills through community-based technology learning centers
(CTLC:s). Microsoft believes that by providing technical skills training, we can
partner with people in the community to create social and economic
opportunities that can help change peoples’ lives and transform communities.

Each course in the UP curriculum is designed for motivated young adult and
adult learners who are seeking to learn new technologies or build on current
technology skills, either for personal or professional reasons. Many of the
Unlimited Potential courses are designed to meet the needs of people learning
to use Microsoft Office applications or the Microsoft Windows XP operating
system in a community learning environment.

By participating in UP courses, students focus on the technical skills they need
to use various software applications. The UP curriculum is constructed on the
belief that successful classroom learning experiences thrive on the following
ingredients:

Prepared instructors
Engaged students
A well-designed curriculum

Sound curriculum design is absolutely critical to learning because the
curriculum provides the courses and instructional experiences offered to
learners.

All UP courses teach technology skills in a hands-on manner that emphasizes
real-world applications of the technology, from basic computer and information
literacy to digital photography, Web page design, or desktop productivity
software.

UP courses are intended for use within community and technology learning
centers, either in the context of classroom instruction or for self-paced learning.
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For courses dealing with introductory information and communications
technologies—computer and information literacy, Internet, World Wide Web,
digital media, and desktop productivity applications—no prior experience with
the technology or software is assumed.

Each course uses tasks and projects to develop basic Microsoft Office
Specialist (MOS) competencies for the desktop productivity applications. In
addition, this curriculum supports certification exam preparation for the
European Computer Driving License and the International Computer Driving
License by covering basic concepts of information technology. The curriculum
also supports Internet and Computing Core Certification (IC3) certification
exam preparation through coverage of computing fundamentals; key software
applications; and networking, Internet, World Wide Web, and electronic mail
(e-mail).

This guide provides you with an overview of the curriculum and course
materials. It includes a brief selection from the Word Processing Fundamentals
Instructor Manual and explains generally how to deliver instruction using the
Unlimited Potential curriculum. The guide concludes with a list of system
requirements, a detailed checklist for getting started with your preparations for
teaching, and steps for installing and printing your courseware materials.

Who This Curriculum Is For

Each course in the Microsoft UP curriculum acknowledges the fact that
community learners typically come to learning experiences with a wide range
of prior experiences, expectations, and skill sets:

Community learners want to spend their time and money wisely.
This curriculum was designed to anticipate, understand, and focus
on the need these learners have for efficient, effective instruction.

Well-designed instruction takes into consideration the community
learner’s prior skill sets and provides new knowledge. This
curriculum accommodates a wide variety of backgrounds and pre-
existing skills. Each course was built with an awareness of
common job tasks and knowledge levels.

Community learners come to learning and expect to be treated as
independent, unique, capable people. This curriculum can be used
in a classroom setting or as a tool for self-directed, self-paced
learning.

Action-oriented, community learners expect learning to be directly
applicable to their professional responsibilities as well as their
personal pursuits. This curriculum contains many examples of
practical, real-world examples and applications designed to appeal
to a wide range of learners.

Above all, each UP course is designed to teach technology skills, but always
with an eye toward the use of technology to enhance individual opportunities,
productivity, job readiness, and quality of life.



Course Offerings and Objectives

The UP curriculum supports Microsoft and international skill standards. As
such, the curriculum provides the following introductory computer, software,
and digital technology courses:

Computer Fundamentals

This course provides a solid foundation in basic computer
concepts and the essentials of hardware, software, operating
systems, the Internet, and more.

Digital Media Fundamentals

This course teaches how to get started with digital media, including
digital photography, audio, and digital video.

Internet and World Wide Web Fundamentals

This course teaches how to explore the Web, use search engines,
work with e-mail, and create Web pages.

Web Design Fundamentals

This course teaches the complete process of Web page design,
from the basics of HTML to strategies for designing and building a
complete Web site.

Word Processing Fundamentals

This course focuses on how to use a word processor to write and
revise a variety of personal and business documents, from simple
letters and memos to complex documents containing graphics and
tables.

Presentation Fundamentals

This course teaches everything you need to know about putting
together persuasive electronic presentations, from creating basic
slide shows, to adding graphics, video, and audio for rich
multimedia presentations.

Database Fundamentals

This course introduces the basics of using a relational database to
create tables, forms, and reports.

Spreadsheet Fundamentals

This course teaches the basics of spreadsheet concepts including
creating worksheets, editing data, building charts and graphs, and
publishing a spreadsheet to the Web.

Each course uses tasks and projects to develop competencies for basic
information technology expertise and desktop productivity applications by
covering the following topics:
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Basic concepts of information technology
Using the computer and managing files
Word processing
Spreadsheets
Database
Presentations
Internet, World Wide Web, and e-mail literacy
Digital media
Key topic areas include the following:
Computing fundamentals (hardware, software, operating system);
Major software applications (office productivity applications); and
Internet, World Wide Web, e-mail, and digital media.

The UP curriculum gives community learners and instructors materials that are
flexible, reliable, cost-effective, and geared toward results. In accordance with
the copyright agreement, all materials and files may be duplicated and
customized by instructors to enhance the learning process.

What Each Course Contains

The elements of each Unlimited Potential course, the use, and the respective
file formats are described in the following table:

Course Element Purpose File Format

Instructor Manual Used by the instructor to | Word document
prepare for and deliver
instruction. Includes
version of Student
Manual with margin
notes for instructor.

Student Manual Primary textbook for Word document
student use in classroom,
lab, office, or home.

Student Practice Files Sample application files | Depending on the

for student use in course, may include
classroom or lab. Word, PowerPoint,
Enables students to Excel, Access,
complete step-by-step FrontPage, NotePad,
procedures and end-of- and various graphics

lesson exercises. file formats.




PowerPoint Slides Visual tool for PowerPoint
instructors to reinforce
learning. Slides include
lesson objectives and
serve as a quick
reference for all major
tasks.

Quick Quiz Answer Key | Students take short Word document
quizzes at the end of
each lesson to assess
what they have learned
and how they would
apply it. The answer key
provides the correct
answers to quiz

questions.
Putting It All Together | Students complete Word document
Answer Key hands-on exercises at the

end of lessons to apply
what they have learned
to real-world projects.
The answer key provides
the best solutions for
each exercise.

Lesson Times Instructors use this Word document
information to determine
instructional times and
customize their courses.

All of the files are customizable, which means that you can print all or part of
any file, such as an individual lesson, or make changes to the lesson materials
and practice exercises to better fit your needs as an instructor.

PLEASE NOTE: The Instructor Manuals for Digital Media Fundamentals
and Web Design Fundamentals do not include instructor annotations.
These courses do include student annotations. Please refer to individual
CD tables of contents for a complete listing of materials on each CD.

Instructor Manual

The Instructor Manual helps instructors prepare for and deliver classroom
instruction using each Microsoft Unlimited Potential course. The Instructor
Manual provides helpful information on planning, preparing for, setting up,
and delivering your Unlimited Potential course with the course materials
provided by Microsoft.
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The Instructor Manual is built around a version of the Student Manual that
contains margin notes—teaching tips, additional information about each topic,
and prompts for when to show certain Microsoft PowerPoint” slides—to
support instruction. As you gain experience in teaching with these materials,
you can customize the Instructor Manual by adding your own notes, variations,
and modifications.

Your first step after assembling the necessary course materials is to read
carefully the “Introduction” to the Instructor Manual, which covers the
following topics:

What instructors need to know to teach the course

What students need to know to take the course

How to plan your course

How to prepare for teaching your course

How to teach by demonstration

How to manage class time

Directing students to additional resources after the class is over
Conventions used in the textbook

Each course has its own Instructor Manual. The Instructor Manual for the
Word Processing Fundamentals course is provided with the Welcome Kit.
You may obtain copies of the Instructor Manual for the remaining courses by
doing the following:

Printing the entire manual from your CD
Printing selected sections and lessons from the manual as needed

Taking the CD to a service center to have the manual printed for
you

You also have the option of reviewing the manual on your computer.

How Each Course Is Set Up

Each Microsoft UP course begins with basic concepts and builds quickly to
intermediate skills and techniques. Practical, hands-on tutorials enable students
to build their skills one step at a time. By studying with a task-based approach,
they learn more than just the features of the software. They learn how to
accomplish real-world tasks so that they can immediately increase their
productivity using the technology.

Each lesson begins with bulleted learning objectives. Each objective specifies
a particular task students will be able to accomplish after completing the
lesson.

Step-by-step tutorials are the backbone of each lesson. The lessons are based
on tasks that students might encounter in the everyday work world. This
approach allows them to quickly see the relevance of the training. The task-



based focus is woven throughout the series, including lesson organization
within each unit, lesson titles, and scenarios chosen for practice files. Concepts
are presented and illustrated with examples from many real-world scenarios,
technology is explained clearly, and hands-on exercises enable students to
begin applying what they know immediately. Most lessons end with 4-5
practice exercises that may build in difficulty and challenge students to
understand and then apply knowledge.

Special Features

Learning objectives. Objectives clearly state the instructional
goals for each lesson so that students understand which skills they
will master. Learning objectives are covered in a consistent way
and they also preview the lesson structure, helping students grasp
key information and prepare for learning skills.

Step-by-step tutorials. Numbered steps give detailed, step-by-
step instructions to help students learn skills. Each tutorial includes
many illustrations to guide students through the learning process.
Sample files are supplied with each course.

Tips. Helpful hints and alternate ways to accomplish tasks are
located throughout the lesson text give students additional
information; point out shortcuts, alternate ways of accomplishing a
task, and possible pitfalls; and provide running commentary on
what they are learning.

Notes. Additional information that enables students to explore a
topic further can be found throughout the lesson text.

Important. Special notes provide cautions or special instructions.

Practice files. Sample documents assist students in completing
exercises showcased at the end of lessons in many of the courses.
Project-based lessons begin with a list of all the files they will need
to complete the project. The course CD-ROM contains the practice
files that students will use as they perform the exercises in the
Student Manual. By using the practice files, students won't waste
time creating the samples used in the lessons, and you can
concentrate on teaching how to use the applications.

Key Points or Lesson Wrap-up. Summaries of what students
have learned in a lesson serve to remind them of key points and
provide direction on what they should do next.

Quick Quiz. Short quizzes at the end of each lesson assess what
students have learned and how they would apply it. This end-of-
lesson assessment goes beyond simple knowledge recall by
asking students to explain how to accomplish certain tasks.

Putting It All Together. These exercises at the end of each
lesson give students practice in applying what they have learned to
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real-world projects. Many of these exercises build on each other to
provide an increasing set of challenges that test their knowledge.

Appendices. The Microsoft Office Specialist Exam Objectives for
each course is listed in an appendix at the end of the book.

Sample Lesson Pages

The following sample pages from the Word Processing Fundamentals
Instructor Manual illustrate many of the special features of each course in the
Unlimited Potential curriculum. The first three pages represent the beginning of
the lesson. The last two pages show the Lesson Wrap-Up, Quick Quiz, and
Putting It All Together student practice exercises.

Notes to the instructor in the margins of the Instructor Manual specify when to
show each PowerPoint slide, making it easy to match the slides to the topic
being demonstrated. The instructor notes also contain additional information
that you might want to mention during the lesson, as well as troubleshooting
hints that might be useful to students. In addition, the margin contains notes
directed at students (these same notes appear in the margin in the Student
Manual). You should point out the information in the student’s margin notes
during the class. Notes to the instructor appear in white typeface on a black
background. Notes to the student appear in black text in boxes.



Instructor margin notes
indicate lesson time
and first slide to show.

LESSON 5

Lesson objectives
clearly state the
instructional goals for
each lesson so that
students understand
which skills they will

master.

Each topic begins with
explanatory
information that
teaches concepts and
techniques.

Students are directed

to practice files.

51

Changing the Layout
of a Document

After completing this |

,» you will be able to:
Adjust page margin settings.
Set paragraph indentation and spacing.

Change indents and rab setfings.

Add page numbers to a document.

L]
|
|
B [nsert and clear tabs.
||
B Create headers and footers,
]

Change page orientation.

Rather than using the default settings that Microsoft Word provides, you can
use other settings and tools to change how vour letters, lists, proposals, and

general correspondence look. One way to quickly customiz

a document is by
changing the way the text appears on the page by altering page margins,
reselting aph alignments, changing tab settings, and creating headers and
footers. When you create a document, you are doing more than just formatting
text; you have the capability to change the page layout of the document by
altering how text appears on the page.

You start this lesson by changing a page margin. A page margin is the amount
of space at the top, bottom, or sides surrounding the text ona

You can

. A header is the
text that appears at the top of a page that usually includes the title of the work,
the date, and page numbers. A footer is text printed at the bottom of the page,
which might include the date, author’s name, and the title of the document

also use a header or footer on a document with multiple pag,

You'll also set tab stops for a particular pa

aph within the document. A tab
stop or tab is used 1o indent the first line of a paragraph or to align text or
numbers in columns, You n columns of text within a
paragraph. Other settings include indents and spacing. Indents determine the

can also use Tabs 1o al

nment of the paragraph in relation to the page margin setting, and spacing

indicates the area above and below the paragraph as well as the space between
the lines.

In this lesson, you will learn how to adjust page margin settings and set
para;

graph alignment, indentation, and spacing. You'll also leam how to change

indents, insert and clear tabs, and add page numbers to a document. In this
lesson, you will also create headers and footers, and change the page

orientation of a document.

To complete the procedures in this lesson, you will need to use the practice file
named Salary Survey 05 in the Lesson05 folder in the Word Processing




Instructor notes contain
additional information for
students—hints, tips,
alternative procedures,
and pitfalls to avoid—
that you might want to
mention during the

lesson.

Margin notes provide
additional explanation
and commentary for
students.

Frequent screen shots
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In the following exercises, the
Standard and Formatting
inolbars have been
separated

You can click the Apply to
down arrow 1o define whether
you want the setup changes
1o apply to the whole
document, the seleciad text
anly, of from the position of
the insartion point forsard

support visual learning of
task-based software use.

5.2 Word Processing Fundamentals

Practice folder that is located on your hard disk. This document was created to
publicize the results of a salary and benefi ministered to a random
sampling of the members of Contoso, Ltd.’s public relations networking group.

Changing Page Margins Using the
Page Setup Dialog Box

When you use the Page Setup dialog box, you determine how the document
appears on the printed page. The Page Setup dialog box is most commonly used
for setting page margins. Page margins affect the entire document because afier
the page margins are changed, the number of pages in the document might
increase or decrease depending on how much text the page margin allows per
page. To change the page margins in a document, you can use the ruler at the
top of the document or the Page Setup dialog box, which is accessed by
clicking Page Setup on the File menu.

By default, Word includes left and right page margins of 1.25 inches and top
and bottom page margins of 1 inch. You use the Page Setup dialog box 1o
adjust top, bottom, left, and right page margin settings, determine the
placement of headers and footers, and select the amount of text that you want

the settings to effect.

Margns | Paper | Layout |

Margns
Top: 11 = Bottom: |1° |
Left. 1.25" = Right: |1 P 'E'
Gutter o —=1 Gutter position: Ii.ef{ b




Instructor margin notes——
indicate slide to show.

Instructor margin notes——
provide additional
explanation and tips for
students.

Step-by-step tutorial
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Lesson 5

Changing the Layout of a Document

In this exercise, you change the page margin settings using the Page Setup
dialoe boy

53

You can also use the up and
down arrows 1o the right of
the settings 10 select preset
sizes. The up amow
Increases the page margin
size, and the down amow
decreases the page margin
size.

procedures provide
immediate, hands-on
learning for students.

E—

Key terms are shown
in bold and defined
the first time they are
used.

There is no visible change to
the text in Normal view.
which is the currently
selected view for the
document.

1

On the Standard toolbar, click the Open button
The Open dialog box appears.
Click the Look in down arrow, click the icon for your hard disk,

double-click the Word Processing Practice folder, and then double-
click the Lesson05 folder.

The contents of the Lesson05 folder appear in the Open dialog box
Double-click the file Salary Survey 05.

The file Salary Survey 05 appears in Word, and the Open dialog
box closes.

On the File menu, click Page Setup.

The Page Setup dialog box appears. The current top margin setting
(17) is selected.

In the Top box, type 1.5, and press Tab.

In the Preview seclion al the bottom of the dialog box, the top page
margin shifts down to show what the text will look like.

In the Bottom box, type 1.5, and press Tab.

In the Preview section, the bottom page margin shifts up.

Click OK.

The top and bottom page margins are now 1.5 inches instead of
1inch

On the File menu, click Save As

The Save As dialog box is displayed.

In the File name box, type Salary Survey 05 Edited

Click Save to save the file in the Lesson05 folder.
Word saves the document.
Keep this file open for the next exercise

To tum the rulers on of off in

Mol view and Print Layout
view, on the View menu, click
Ruler

Changing Page Margins Using the
Ruler

> ruler. The ruler is a scale shown
or other units of
ew and both horizontal and

vertical rulers in Print Layout view are provided in Word.

T'o use the nuler, you should use Print Layout view, not the default setting of
Normal view, so that you can see the page margin settings relative to the page
borders. You use Normal view to edit and format the document, but Normal

view doesn’t show the page
use Print Preview to vie

rgins relative to the page borders. You can also
our document as it will be printed, and you can

make changes to the margins in this view.
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Lesson 5 Changing the Layout of a Document 5.21

Lesson Wrap-Up

Lesson Wrap-Up

In this lesson, you leared how to change page margins, format paragraphs, and
covers remaining file set and change tab stops. You also leamed how to create headers and footers,
insert page numbers, and change the orientation of a document.

administration issues If you are continuing to other lessons:

to end the lesson. 1 On the Standard toolbar, click the Save button to save changes
made to the file that you edited
Word saves the changes

2 Onthe File menu, click Close to close the file.
Word closes the file.

If you are not continuing to other lessons:

1 On the Standard toolbar, click the Save button to save changes
made to the file that you edited.
Word saves the changes.

2 In the upper-right corner of the Word window, click the Close

button
The Word program closes.
Quick Quiz short- Quick Quiz
answer questions quiz 1 Name three ways in which you can change the page margins in
Word

students on the lesson

2 How is vertical alignment similar and different from horizontal
concepts. alignment?

3  How do you display the measurements of the page margins?
4  How do you display the Headers and Footers toolbar?

5 What's the difference between the Left Indent marker and the Left
Page Margin marker on the ruler?

6 How do you clear a tab stop?

7  How do you specify thal you want to insert a page number in the
upper-right comer of the document?

8  When the headers and footers boxes are displayed, what two ways
can you switch between the header and the footer?

9  When you delete a paragraph mark, what formatting charactenstics
does that paragraph take on?
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5.22 Word Processing Fundamentals

special instructions.

Putting It All

important

In the Putting It All Together section that follows, you must complete
Exercise 1 to continue to Exercise 2.

Together exercises
challenge students to
apply what they
have learned and
require them to
apply skills in a new
way.

Putting It All Together

Exercise 1: |1 necessary, start Word. Open a new, blank Word document.
Adjust the left and right page margins to 2 inches and change the orientation

to landscape. Insert tab stops at 2 inches, 4 inches, 6 inches, and 8 inches. The
6-inch tab stop should be a decimal tab and the 8-inch tab stop should be a right
tab. Type the following headings in the first line:

Years Expericnce, Base, Mean, and 90%.

Insert a new line, make heading text bold, and then save the document as
Practice 05.

You will use E

ercise | to complete the following exercise.

Exercise 2: Type the following information on the next two lines, pressing
Tab between the entries.

Less than 2 vears a7 $37,940 $43.250
2-5 years 164 541,650 £55,000

Create a centered heading with the title Survey Results and a footer with the
current date on the left and Page X of ¥ on the right (where X is the current
page and ¥ is the number of pages). Save the file in the Lesson03 folder, and
close the document.

Exercise 3: In the Header and Footer toolbar there is an Insert AutoText
button. Open a new blank document and experiment with the various options
available through this feature. Save the file in the Lesson05 folder, and close
the document.

Exercise 4: In your open document, set up a list of your favorite musical
artists. Set a Lefi tab at 17 and enter the name of the group or musician. Set
another Lefi tab and enter the name of a CD you own by this artist. If you own
multiple CDs, press Enter and press Tab twice to enter each of the CDs you
own in a separate line of text. Next to this information, set a Right tab at 57 and
rank each CD on a scale of 1 to 10 (least favorite to favorite). Fill in the
information for several artists. Save the file in the Lesson03 folder, and close
the document.

Exercise 5: In this lesson we adjusted the spacing after a paragraph. What
other Spacing options are available for paragraphs and for lines? Explore the
Paragraph dialog box or use Word's help files to find out more about paragraph
and line spacing.
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Delivering Instruction Using the
Unlimited Potential Curriculum

There are as many ways to present instruction in a classroom as there are
instructors to present it. You can adapt the materials in this Unlimited Potential
course to fit your own delivery process and style. What follows is just one
possible way to use the materials in this series. Feel free to customize the
course to fit the needs of you and your students. In accordance with the
copyright agreement, all materials and files may be duplicated and customized
by instructors to enhance the learning process.

The lessons are modular: they can be taught in any order. However, for best
results, avoid starting a class in the middle of a lesson. Each lesson should be
completed sequentially from start to finish.

Using the Student Manual Features

Each lesson in the Student Manual has numerous features to assist students in
the task of learning. The following list describes one way that these features
can be used in the classroom.

Practice files. All files that students need to practice the new skills
taught in the lesson are located on the CD. (Instructions for
installing the practice files are located in the “Installing the Course
Files” section at the end of this document.). Instructors can also
use the practice files for demonstrations during the class.

Margin notes. The notes to the instructor in the margins of each
Instructor Manual include prompts that specify which slide to show,
making it easy to match the slides to the topic being demonstrated.
The instructor notes also contain additional information that you
might want to mention during the lesson and troubleshooting hints
that might be useful to students. Also in the margin are notes for
students. You should point out the information in the student’s
margin notes during the class. Instructor notes appear in a white
typeface on a black background. Student notes appear in black
text in boxes.

Tips. Pointing out the “tips” during lessons helps to ensure that
students see and understand the Tips provided.

Important notes. Notes labeled “important” point out steps or
options that are essential to successfully complete the exercise at
hand. Make sure that students pay attention to the notes and
understand the information provided in them.

Using the Quick Quiz Assessment Questions

At the end of each lesson in the Student Manual, a number of Quick Quiz
questions are provided to check students’ knowledge. Each question can be
answered with one or a few sentences. Although you could have students write
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the answers to the questions on paper, some learners may respond better if you
ask the questions at the end of each lesson and provide students with the
opportunity to respond orally.

An answer key is provided for all of the Quick Quiz assessment questions. This
answer key is located on the course materials CD-ROM and can be installed
along with the other instructor resources. You might find it useful to print this
document and keep the pages handy as you listen to students’ responses to the
Quick Quiz questions for a given lesson.

Using the Putting It All Together Practice
Exercises

The purpose of the Putting It All Together exercises is to reinforce learning by
having students apply what they have learned in a new way. These exercises
describe the task to be completed, but they do not provide the step-by-step
procedures for how to complete the task. Therefore, these exercises provide an
excellent way for students to demonstrate their mastery of the new skills taught
in the lesson. Options for their use include the following:

Students can work on these exercises during class time or outside
of class.

You can point out the exercises as a method to practice new skills
with different examples. If students will be completing any of these
exercises outside of class, you might want to provide the solution
files to them so that they can check their work on their own.

Answer files are provided on the course CD-ROM for all of the Putting It All
Together exercises, showing detailed steps for completing each exercise.
Because there is more than one way to use many of each application’s features,
you should consider these solutions as suggested steps only. The focus should
be on ensuring that students achieve correct results. Students should be
commended if they arrive at a correct solution to an exercise but follow
different steps.

Using the PowerPoint Slide Presentations

The PowerPoint slide presentation provided for each lesson is a tool to help
reinforce learning. You’ll have many different types of learners, and the
addition of slides helps visual learners so that you can reach more students in
the class. You can use the slides in a couple of ways:

Previewing the lesson by reviewing the lesson objectives on the
slide helps students understand what they will be learning and how
to fit the tasks that they learn into the context of a lesson.

Viewing the quick reference steps for a task can enhance retention
when students try completing tasks on their own.

For each lesson, Microsoft PowerPoint slides are provided to assist you in
explaining and demonstrating concepts. You’ll find slides for the lesson
objectives and for many of the procedures that students perform. You can print



Show slide 04 Formatting
Text 9, Using Drag and Drop

to Edit Text.
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slides and use them to create transparency masters, or you can display the
presentations directly from within PowerPoint by using a projector connected
to your computer.

For each presentation, slides are named and numbered in the sequence in which
you should present them. Each slide is named to correspond with the lesson
name or the lesson concept under discussion. For example, when you open the
presentation for Lesson 4, Formatting Text, of the Word Processing
Fundamentals course, the first slide is 04 Formatting Text 1, and it shows the
set of objectives for the lesson. Slide 9, which corresponds to the steps used in
the exercise on using drag and drop to edit text, is titled 04 Formatting Text 9,
Using Drag and Drop to Edit Text.

In the Instructor Manual, you’ll find margin notes that indicate when you
should display a particular slide (see sample margin note to the left). To display
slides in PowerPoint, open the presentation and click View Show on the Slide
Show menu. You can navigate sequentially through slides by clicking the
mouse button or by clicking the Next button in the bottom-left corner of each
slide. You can navigate backward through slides by clicking the Back
navigation button in the bottom-left corner of each slide or by right-clicking the
current slide and clicking Previous on the shortcut menu that appears.

Before you teach your first class, try going through the course with the
PowerPoint slides. This can help you determine how long it takes to present the
lesson material using the slides.

All PowerPoint presentations are found on the course materials CD-ROM. You
have the option to install these files along with other instructor resources.

System Requirements

Each classroom or community learning center computer system must meet the
following minimum guidelines to run Microsoft Office XP and enable students
to work with the practice files used in many of the lessons.

e A personal computer running Microsoft Office XP on a Pentium 133-
megahertz (MHz) or higher processor

e Windows XP operating system

e A minimum of 128 MB of RAM plus an additional § MB of RAM for
each Office program running simultaneously

e Atleast 58 MB of available disk space (after installing Microsoft
Office XP)

e A CD-ROM drive

e A monitor with Super VGA (800 x 600) or higher resolution with 256
colors; 15-inch display screen or larger recommended

e A mouse, an IntelliMouse”, or other compatible pointing device
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Installing the Course Files

To install the course files on your computer:

1 Insert the CD-ROM in the CD-ROM drive. An End-User License
Agreement appears.

important

If the License Agreement does not appear, right-click the Start button and
click Explore. Windows Explorer displays in folder view. In the left pane,
locate the icon for your CD-ROM and click this icon. In the right pane,
double-click the file StartCD.exe.

2 Select | accept this agreement and then click (only once) Next. A
starting menu will be displayed.

3 To view general instructions about the CD-ROM, click (only once)
the View Readme menu option.

4  Toinstall the Student Lessons, click (only once) the Install
Student Lessons menu option and follow any prompts that appear
on your screen.

5 To install the Practice Files, click (only once) the Install Practice
Files menu option and follow any prompts that appear on your
screen.

6 To install the Instructor Files, click (only once) the Install
Instructor Files menu option and follow any prompts that appear
on your screen. When you select this option, an Instructor Files
folder is installed in addition to the following folders and files:

0 Instructor Manual subfolder containing the following:
= Cover page
=  Copyright page
= Table of contents page
= Preface
= Introduction
= Annotated course lessons

= Microsoft Office Specialist Exam Objectives
Appendix

= Back cover

0 “How to Print” text file explaining how to print the Instructor
Manual
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o Slides subfolder containing all of the slide presentations for
the course

0 How to Use the Unlimited Potential Curriculum document
0 Quick Quiz Answer Key document
o0 Putting It All Together Answer Key document
0 Lesson Times document
0 Course Completion Certificate
o Course Feedback Forms
7 After the course files have been installed, click Exit.

8 Remove the CD-ROM from the CD-ROM drive.

Installing the Practice Files to
Student Computers

To prepare for class, you should install the practice files provided on this CD-
ROM on each classroom computer. These practice files are used throughout

many of the Unlimited Potential courses so that students can perform only the
tasks required for each lesson, rather than creating new files for each exercise.

To install the practice files on each classroom computer:

1 Insert the CD-ROM in the CD-ROM drive. A starting menu appears.
2 Click (only once) Install Practice Files and follow the prompts.

3 After the practice files have been installed, click Exit.
4

Remove the CD-ROM from the CD-ROM drive.

Uninstalling the Practice Files

By default, all the course files have been installed to the location ¢c:\Unlimited
Potential on the computer’s hard disk. The files for each course are installed to
the folder named for that course (for example: c:\Unlimited
Potential\Computer Fundamentals).

To uninstall the practice files for a course, start Windows Explorer and
navigate to the \Unlimited Potential folder. In the left pane, click on the course
folder (for example: \Computer Fundamentals). In the right pane, right-click
the Practice folder you wish to remove (for example: Computer
Fundamentals\Practice) and click Delete.
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important

Deleting the practice files and then reinstalling them ensures that all files
and folders are in their original condition in preparation for the next class.

Adjusting the Paper Size to Print on
A4 Paper

To change the paper size from the default setting of “Letter” (8.5 inches by 11
inches) to “A4” (8.27 inches by 11.69 inches) follow these steps:

1 If necessary, start Word.

2 Navigate to the Student Lessons folder on your hard drive and click
the file you want to print.

The lesson file opens in Word.

3 From the File menu, choose Page Setup. The Page Setup dialog
box is displayed, as shown in Figure 1.
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Page Setup

Margins | Paper Layout | Daocument Grid

Margins

4

Top: 1. ' Bottom: |1
Left: Right: |0.92
Gutker: Gukter position: | Left

Orienkation

A)

Partrait Landscape

I!

Pages
Multiple pages: |N|:-rmal L

Presview
apply to:
Whole document W

-

Figure 1: Page Setup dialog box.

4 Click the Paper Tab of the Page Setup dialog box. The paper
tab lets you specify the paper size and source.

5 In the Paper Size list, choose A4 in the drop-down list, as shown
in Figure 2. (The contents of this list depend on your current
default printer.)
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Page Setup

Margins | Paper |La~;.ﬂ:|ul: Docurnent arid

Paper size:
19
wWidth: g.27" E

Height: 11.69" e

Paper source

First page: Qther pages:

Default bray (Aukamatically 5 Default bray (Automatically 5

Aukamatically Select Automatically Select

Upper Paper Tray Upper Paper Tray

Manual Paper Feed Manual Paper Feed

Envelope, Manual Feed Envelope, Manual Feed
Presview

apply to:

|'u'-.-'hu::|e docurnent W |

o (e

Figure 2: The Paper tab of the Page setup dialog box lets you specify the paper
size and source.

Click OK.
Click the Save button.
Click the Print button to print the document on A4 paper.

© 00 N O

Click the Close button to close the file and exit Word.
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Unlimited Potential Curriculum

Support

If you have questions or comments please contact your local Microsoft
Community Affairs Representative or email us at UPInfo@microsoft.com.

Microsoft Corporation
One Microsoft Way
Redmond, WA 98052-6399
USA

Phone: 425.882.8080
www.microsoft.com

Microsoft Asia Pacific
5 Temasek Boulevard
#09-03 Suntec City
Tower 5

Singapore 038985
Phone: 65.6337.6088
www.microsoft.com/asia

Microsoft Greater China
19/F Millennium Tower
38 Xiaoyun Road
Chaoyang

Beijing 100027

P.R. China

Phone: 86.10.8453.8989
www.microsoft.com/china

Microsoft Japan

Odakyu Southern Tower
2-2-1 Yoyogi

Shibuya-ku, Tokyo
151-8583 Japan

Phone: 81.3.5454.8000
www.microsoft.com/japan

Microsoft Latin America
899 West Cypress Creek Road
Suite 400

Fort Lauderdale, FL 33309
USA

Phone: 954.489.4800
www.microsoft.com/latam

Microsoft Europe, Middle East, &
Africa

Coeur Défense, Tour B-37¢ étage
100 Esplanade du Général de Gaulle
92932 Paris La Défense Cedex
France

Phone: 33.01.70.99.10.67
www.microsoft.com/emea

Microsoft Canada

1950 Meadowvale Boulevard
Mississauga, Ontario

L5N 8L9

Canada

Phone : 905.568.0434
www.microsoft.com/canada

To learn more about Microsoft’s programs in the community and about
Unlimited Potential, please visit us at www.microsoft.com/unlimitedpotential.
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Checklist for Getting Started

Follow the directions under “Installing the Course Files” for installing all
of the course files to your hard drive.

Print one copy of How to Use the Unlimited Potential Curriculum.

Print one copy of the Instructor Manual and follow the instructions in the
Introduction for preparing to teach your first class.

Review the margin notes in the Instructor Manual for suggestions on
where to show slides and how to teach each of the lessons.

Review the PowerPoint slides for each lesson.

Make multiple copies of the Student Manual for class. If this is not
possible, you can print one lesson at a time.

Print one copy each of the Lesson Times, Quick Quiz Answer Key, and
Putting It All Together Answer Key.

Use the Lesson Times document to plan your course, adjusting the class
syllabus accordingly to meet your needs.
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